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Before you start using the software, we recommend that you 

understand the Pacesetter BES Monogramming Suite design 

workspace and learn a few of the basic components outlined in 

this section.

Topics covered in this chapter:

• Setting up the design workspace environment.

• Showing a hoop in the workspace, and choosing the size of 

hoop to be displayed.

• Using the Pacesetter BES Monogramming Suite help.

CHAPTER 1:

Learning about the 
Workspace
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Parts of the Workspace
The Pacesetter BES Monogramming Suite workspace contains 

a number of different areas which have distinct functions. The 

sections that follow give an overview of what each of these 

areas does, and the kinds of information about the design that 

they contain.

Title Bar
The Title Bar appears at the top of the Pacesetter BES 

Monogramming Suite design window. The Title bar displays 

information about the design that is open in the workspace: its 

name, the number of stitches and colors in the design, and the 

overall width and height.

Pacesetter Button
At the top left-hand corner of the window is the Pacesetter 

button . Clicking this button gives you access to a menu of 

useful tools, such as New, Save, Print, and several others. For 
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a complete list of the tools available on this menu, and a 

summary of their functions, see “Pacesetter Menu Tools” in the 

next section. 

When you open the Pacesetter Menu, you will also see 

displayed a list of recent files that you have been using. Just 

double-click on the file name to open it.

Tools available on the Pacesetter Menu.

Quick Access Toolbar
The Quick Access Toolbar is located right along the top of your 

workspace, to the left of the Title Bar. This toolbar contains tool 

buttons that you will commonly use, such as Open, Save As, 

and Print.

The following default tools are included on the Quick Access 

toolbar: New, New/Recipe, Open, Merge, Save As, Direct Print, 

Print Preview, Undo, and Redo. 
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Toolbar and Ribbon Buttons
You can access the tools available in Pacesetter BES 

Monogramming Suite through the Pacesetter Button  and 

the various toolbars. The tables below show the buttons, 

grouped by location (i.e. whether they are on the Quick 

Access Bar, or on one of the tabs on the ribbon). A brief 

description of what the button does is also included. Note 

that within each tab, some buttons are grouped together by 

function.

Pacesetter Menu Tools

Tool What it means

New: Creates a new untitled design.

New/Recipe: Opens a new page and allows you to choose a 
new recipe and machine format.

Open: Opens an existing design file.

Merge: Opens the Merge Design dialog, which you can use to 
import existing stitch or outline files into the current design 

Save: Saves the current design.

Save As: Opens the Save As dialog, allowing you to choose 
the destination and file type to save it as.

Print: Opens the printer dialog on your computer, allowing you 
to choose your printer and adjust the printer’s properties. 

Print Preview: Opens the print preview window, which in turn 
will let you print the current design.

Print Setup: Opens the print preview window, which in turn 
will let you print the current design.

Close: Closes the file that you are currently working on. 
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Ribbon Tools
The Ribbon appears below the Title Bar. The Ribbon has three 

tabs: the Home tab, the Arrange tab, and the View tab. Clicking 

on the tabs displays all the buttons for the functions that are 

under that tab.

Tools on the Home Tab

Exit: Closes all open files and shuts down Pacesetter BES 
Monogramming Suite; you will be prompted to save any open 
files.

Undo: Reverses your last action.

Redo: Reverses the action of the Undo command.

Tool What it means

Select: Selects objects in the design window.

Cut : Cuts the selection and copies it to the clipboard.

Copy: Copies the selection to the clipboard.

Paste: Pastes the clipboard contents into the design, at 
the end of the design sequence.

Insert: Pastes a copy of the clipboard selection into the 
sewing sequence immediately following the selected 
segment. 

Delete: Removes the selected segment.

Monogram Designer: Opens the Monogram Designer 
dialog.

Color Sort: Automatically reduces the number of thread 
changes required within the selected objects by 
resequencing like colors together.

Tool What it means
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3D: Realistically renders your design onscreen.

Grid: Displays a background grid, which helps with 
alignment. This grid can be used for the alignment of 
items on the display.

Hoop: Displays the hoop as it fits relative to the 
embroidery. Clicking this button a second time will turn 
the view of the hoop off. 

Select Hoop: Accessed via the drop-down menu from 
the Hoop tool. Opens up the Hoops window, in which you 
can choose a new hoop.

Fit to Hoop: Scales the design up (or down) to the 
maximum size of the current hoop on the design window.

Background: Two options are available from this button, 
Select Color or Select Fabric. Depending on which one 
you choose, a dialog box will open in which you select 
either the color, or the fabric pattern, that appears in the 
background of the active design window.

Ruler: Measures the distance between any two points in 
a design.

Zoom: Magnifies the design to fit a rectangle drawn by 
the user with the mouse pointer.

Zoom in: Magnifies the view of the design by a fixed 
amount.

Zoom out: Shrinks the view of the design by a fixed 
amount.

Fit to Window: Displays the entire design and loaded 
images in the window.

Back to 1:1: Returns design to original size.

Slider: Drag the slider to choose a specific level of 
magnification; displays percentage of original size.

Pan: Allows you to move the design around in the 
workspace window by clicking and dragging.

Tool What it means
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Tools on the Arrange Tab

The View Tab
The controls on the View tab allow you to change what appears 

on your workspace; which panels are displayed, and so on. The 

areas found on this tab are Windows and Program Preferences.

Windows
In the windows area, check the box to show the corresponding 

window or panel, and uncheck it to hide that window or panel.

• Sequence View. Shows/hides the Sequence View panel.

• Palette. Shows/hides the thread palette.

• Properties. Shows/hides the properties panel.

• Simulator. Shows/hides the sewing simulator.

• Status. Shows/hides the status bar.

Tool What it means

Select: Selects objects in the design window.

Horizontal Center: Takes all selected objects and centers 
them in the selection box. The objects are moved so that they 
are centered left-to-right with each other, but they are not 
moved up or down.

Vertical Center: Takes all selected objects and centers them 
in the selection box. The objects are moved so that they are 
centered top-to-bottom with each other, but they are not 
moved left or right.

Center: Centers one or more selected objects proportionally 
within the current hoop.
If more than one object is selected, the entire group is moved 
together to the center of the hoop; the objects selected remain 
in the same position relative to each other as they had before 
being centered.

Flip Horizontal: Flips one or more selected objects 
horizontally.

Flip Vertical: Flips one or more selected objects vertically.
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Program Preferences

Click on the Program Preferences  button to open a dialog 

in which you can set the default machine settings, change the 

units of measure, and choose settings for the workspace grid. 

For more information on this dialog, see “Setting up your 

Workspace Environment”

Simulator
The Simulator makes it easy to see on-screen how your design 

will sew out. You can use the Simulator to eliminate potential 

sewing problems.

When you select Simulator from the View tab of the Ribbon, the 

Simulator (scrollbar slider and the sewing simulator) will appear 

at the bottom of the design space. The Simulator controls which 

parts of the design are drawn in the design window.

Scrollbar Slider

The length of the Scrollbar Slider represents all of the stitches 

in the opened design. You can move the scrollbar slider by 

dragging it to see a design as it will look sewn to a particular 

point. The color display within the scrollbar indicates the thread 

color that will be sewn when the scrollbar slider is positioned 

over it. Clicking on the arrows at the ends of the scrollbar will 

advance or retrace the design position by one stitch.

Sewing Simulator

The sewing simulator allows you to watch your design draw on 

a stitch-by-stitch basis, simulating the sewing action of your 

You can also open and close the Simulator by pressing Ctrl + R.
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machine. The Simulator controls include pause, stop, sew 

forward and sew backwards. You can push various control 

buttons and slide the speed control to vary the rate of sewing.

Using the Simulator

The following table explains how to use the Simulator in more 

detail:

Status Line
The Status Line appears at the bottom of the BES 

Monogramming Suite window. To show or hide the Status Line, 

go to the Windows area of the View Tab and check or uncheck 

Status.

As you move the mouse over different sections of the 

workspace, this indicator will tell you what that area or button 

does. You will also find specific design information in other 

Tools What is does

Previous Stitch: Move backward in the design by 
one stitch.

Scrollbar slider: Drag the scrollbar slider to 
advance the design to a specific position. When the 
scrollbar slider is positioned over a color, you will 
see the specified thread color being sewn in the 
design. The entire length of the scrollbar slider 
represents the entire design.

Next Stitch: Move forward in the design by one 
stitch.

Simulate Sewing (backward): Move backward 
through the design.

Pause/Stop: Pause or stop the design while 
drawing. When you play or resume sewing your 
design, stitching will continue from the location of 
the last stitch.

Simulate Sewing: Move forward through the 
design.

Speed: Slide the speed control to vary the rate of 
sewing.
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areas of the status bar; it shows the total number of segments in 

the design, the number of segments currently selected, the 

machine format, the recipe used by the current design, the 

number of stitches in the selected design components and the 

hoop being used.

Color Palette
The thread colors for the design are shown in the Color Palette 

located along the top edge of the workspace. To show the Color 

Palette (if it is not already displayed), go to the Windows area of 

the View tab and check the Palette box. 

The color palette in Pacesetter BES Monogramming Suite

For more information on the color palette, see “Changing 

Thread Colors” in the “Editing Designs” section of this manual.

Using Scrollbars
The scrollbars enable you to move easily around the displayed 

design. There are two scrollbars, one for moving the view 

vertically, and one for moving it horizontally.

How to use the scrollbars:

• To pan left/right, or up/down, click and drag the track button 

.

• Click on the small arrows at each end of the scrollbar to 

move the design view incrementally.

• Click in the track of the scrollbar, to move the workspace 

view by one whole screen.

You can also right-click the scrollbar to display a pop-up menu 

of scroll actions. The pop-up menu gives you the following 

options:
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Correcting Mistakes
Undo and Redo are two significant features that allow you to 

correct mistakes. If you make a mistake and change your mind 

about an action you just made, Undo reverses the action. Redo 

puts back the change. If Undo or Redo are grayed out, you 

cannot Undo or Redo. 

To use Undo: 

• Do one of the following: 

 On the Quick Access toolbar click the Undo  tool. 

 Press Ctrl+Z on your keyboard.

To use Redo: 

• Do one of the following: 

 From the Quick Access toolbar, click the Redo  tool.

 Press Ctrl+Y on your keyboard.
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Opening and Closing Designs
When you open a *.BRF file in Pacesetter BES Monogramming 

Suite, this file will contain both outline and stitch information. 

Note however, that when you open other file types, they will 

open as stitch segments only.

To open an existing design:

1 To open an existing design, do one of the following:

 Click the Accelerator  button, and select Open from 

the menu that appears.

 On the Quick Access toolbar, click on the Open Design 

 tool.

You see the Open Design dialog box.

2 In the Look in list, browse to the location of the file you want 

to open.

3 In the Files of type list, select a design file type for the 

design you want to open.

4 In the File name box, enter the file name, or select the file 

you want to open by clicking the file.

5 Select Preview to view a thumbnail (a small representation) 

of the design. 

6 Click Open.

To close a design:

• Click the Accelerator  Button, and select Close  

from the menu.
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Creating New Designs
When you open Pacesetter BES Monogramming Suite, you can 

immediately begin creating a new, untitled design in the design 

window. The design window automatically opens using the 

default recipe and machine format settings specified in the 

Preferences dialog. For more information on default settings, 

see “Setting up your Workspace Environment”.

If you want to start a new design and apply a different recipe to 

it (that is, not the default recipe), use the New/Recipe  tool. 

To create a new design using the recipe dialog:

1 Click the Accelerator , and select New/Recipe .

You see the New Page dialog.

2 In the Recipe list, select the recipe you want to use for your 

design.

3 In the Machine format list, select the machine format that 

you want applied to the design when created.

4 Click OK. 

You see a new design window.

If you select the New tool from the Quick Access toolbar, you 
will bypass the recipe selection dialog. A new design window 
will open using the default recipe and machine format settings.

The Recipe description box in the dialog gives you a brief 
description of each recipe as you scroll through the list in the 
Recipe drop-down list. 
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Saving Designs
Use the Save As command to save designs. The Save As 

command lets you save an alternative version of the design with 

a different name, location, or file format. Embroidery designs 

can be saved in a number of different formats. The default 

format is the in the Pacesetter outline format (*BRF), but you 

can also choose from a large number of machine (stitch) 

formats, such as  *.PES, *.SEW, *.JEF, etc.

Regarding outline vs. stitch formats: 

Files saved as the outline format (*.BRF). will contain both 

outline (vector graphic) information and stitch information. 

Designs saved in this format can be edited without 

compromising the quality of the stitches, because the stitch 

information is regenerated when segments are resized. 

If the file is saved in machine format, on the other hand, it will 

contain only stitches, without any outline information. When 

resizing these types of files, the lack of vector outlines means 

that the regeneration of stitches cannot be done as well as it is 

for segments that do have outlines. Therefore, it is recom-

mended that you save all newly-created designs as *.BRF at 

first. Then, do any editing that is necessary, and only save your 

design in machine format when it is all ready to be sewn out.

To save a design:

1 Do one of the following.

 Click the Accelerator button, and select Save As from 
the menu that appears.

 On the Quick Access toolbar, click on the Save as  

tool.

Important: It is possible to have stitch (i.e. non-outline) 
segments in an outline (*.BRF) file. For example, those that are 
imported into your *.BRF using the Merge command.

If the file you merge into your outline file is in stitch file format, it 
will still be a stitch-only segment, even thought it is part of an 
outline file; therefore, the same cautions about re-sizing apply. 
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You see the Save As dialog box.

2 In the Save in list, browse to the location you want to save 

your file.

3 In the File Name box, enter the file name for the design you 

want to be saved.

4 In the Save As type list, select the file type you want the 

design to be saved as.

5 Click Save.

Setting up your Workspace 
Environment
You can set up your design workspace environment for all 
opened design files. You can predetermine the units of 
measurement you want to use for your designs. 

The following sections describe the units of measurement that 

can be used for designs opened in Pacesetter BES 

Monogramming Suite.

Metric

The dimensions in Pacesetter BES Monogramming Suite can be 

displayed in metric values. This is the default setting, which will 

appear each time you run the software. It is generally preferable 

for embroiderers to use the metric values because many of the 

manufacturers of embroidery machines and designs use metric 

values.

English vs. Metric

Pacesetter BES Monogramming Suite displays inch 

measurements in tenths of inches. If you think in inches, then 

you can set the software to use the inch system.

To simply save the changes you make to the current design, 

use the Save  tool. 
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To set up your workspace environment:

1 On the View tab of the Ribbon, select the Preferences  

button.

You see the Preferences dialog box.

2 Click the Environment tab.

3 From the Units list, select the units of measurement you 

want used for your designs: Metric or English.

4 Click OK.

Changing Machine Format 
Properties
All designs in Pacesetter BES Monogramming Suite have a 

machine format. Machine formats have their own profile settings 

that determine how embroidery information will be interpreted 

when you save design files. 

When you create a new design file, you can select the machine 

format for the specific design. The selected machine format can 

change how the design file is read. When you set machine 

format properties in the Preferences dialog, all new designs will 

use these machine format properties as the default settings.

To change machine format properties:

1 On the View tab of the Ribbon, select the Preferences  

button.

2 Click the Formats tab.

3 From the Machine format list, select the machine format that 

you want applied to new design files.

4 Click OK.

If you open a design with the New/Recipe command, you can 
select the recipe for the new design in the New Page dialog. 
This will override whichever recipe is set as the default in the 
Preferences dialog.

Changing machine format properties after a design file has 
been opened will not change the machine format of the 
embroidery designs in that design. 
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Adjusting the View of the 
Workspace

Magnifying and Reducing the View
Use Zoom to magnify or reduce parts of your design. With Zoom 

you can either left-click to enlarge your design or right-click to 

make your design smaller.

When you select Zoom, the cursor changes to a small 

magnifying glass . To use the Zoom tool, do one of the 

following: 

• To zoom in on the spot where the mouse is currently 
pointing, left-click.

• To zoom out a4gain, right-click.

• To zoom in on a particular area, left-click and drag; the 
display will expand to show only the area that you have 
dragged over.

To use the Zoom Tool: 

1 On the Ribbon, select the Home tab.

2 In the Zoom toolbar, click on the Zoom  tool.

The pointer becomes a magnifying glass.

3 Do either of the following:

 Left-click to make your design larger. 

 Right-click that area to make your design smaller.

To zoom-in on a specific area:

1 On the Ribbon, select the Home tab.

2 In the Zoom toolbar, click on the Zoom  tool.

The pointer becomes a magnifying glass.

3 Click and hold your mouse button and drag it to form a 

flexible box around the area you want to see in detail.
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4 Do one of the following:

 To increase the zoom, continue clicking and dragging the 
flexible box.

 From the Zoom toolbar, click on the down arrow under 
the Zoom icon, and use the Zoom tool settings to zoom 
back out.

Additional options on the Zoom Toolbar:

When you click on the down arrow underneath the Zoom Tool, 

you will see an option menu. You can choose from any of the 

following options on this menu:

• Zoom In to make your design larger.

• Zoom Out to make your design smaller.

• To Fit to make the whole design the size of the design 
window.

• To Selection to zoom to the size of the currently selected 
embroidery segment, or set of embroidery segments if more 
than one is selected.

• 1:1 to see the design at the actual size.

Hiding Panels Automatically
To increase the amount of space for your design window, you 

can set the Properties and Sequence View panels to the Auto 

hide mode. When Auto hide is on, the panel will only be visible 

while the mouse is over it; as soon as you remove the mouse, 

the panel will collapse to a narrow sidebar. 

To turn on Auto hide for these panels, click on the small push-

pin icon  at the top-right of the panel. When the panel is in 

Auto hide mode, the small push-pin will be on its side, like this: 

. Now, whenever you move the mouse to another part of the 

screen, the panel will be hidden.

To turn Auto hide off, click on the  icon again.
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Adjusting the Position of the Panels
By default, when you first open the software, the Properties and 

Sequence View panels appear “docked” in your workspace.

However, there are ways to move any of the panels around into 

different positions; you can “float” them above the workspace, in 

which case they can be moved anywhere on your desktop; or 

you can undock them from their current positions and dock them 

elsewhere.

You can also combine panels together by “tabbing” them; you 

do this by floating a panel in front of another panel and then 

docking it to that panel with the tab  button.

To float a docked panel:

1 Right-click on the panel’s title bar (the grey area at the top of 

the panel, which shows the panel’s name, e.g. “Properties”).

You will see a menu of options.

2 Select Floating from this menu.

The panel now floats above the workspace; you can drag and 
place it anywhere on your screen.

To hide a panel:

1 Right-click on the panel’s title bar.

You will see a menu of options.

2 Select Hide from this menu.

If you wish to re-dock the panel to the same location it was 
originally, you can just right-click the title bar again and select 
“Docking” from the menu; the panel will immediately go back to 
the former location. To dock it elsewhere, follow the steps under 
“To dock a floating panel”.
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The panel will no longer be visible; to show the panel again, 
go to the Tools tab of the ribbon, and in the Windows area 
check the Properties check box.

To dock a floating panel:

1 Left-click the panel’s title bar and drag it a short distance, 

continuing to hold down the mouse button.

You will see a set of arrow buttons displayed in the 
workspace. Five of them (four arrows plus the tab button) 
form a cross shape, like this:

There will also be four isolated arrow buttons like this  
pointing at the four sides of the main window.

2 Do one of the following:

 To dock to the sides of a frame, drag the cursor over one 
of the arrow buttons in the cross.

A shaded area will appear, previewing the position that the 
floating panel will dock. In the instance shown below, the 
Sequence View panel is set to be docked to the left of the 
design workspace.
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 To dock to the top, bottom, left or right sides of the 
overall workspace window, drag the cursor over the 
corresponding isolated arrow button.

 To make the selected panel into a tab of another panel, 

move the cursor over the tab  button in center of the 

“cross”.

3 Release the mouse button.

The floating panel will now be docked to the selected 
location, and tabs labelled “Properties” and “Color Palette” 
will appear along the edge of the panel.

Viewing Different Parts of the 
Workspace (Panning)
Sometimes you may want to work at a high level of 

magnification, and some part of the garment or embroidery 

you’re working on will not show up in the workspace.You can 

move to parts of your design that go beyond the window’s 

borders. In these situations, you can use keyboard arrows or 

the pan tool to change your view of the project.

Panning using the keyboard:

• Use the  key to move up.

• Use the  key to move down.

• Use the  key to move left.

• Use the  key to move right.
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Using the Pan Tool

Use the Pan  tool to move the view of the design around in 

the workspace by clicking and dragging. While you are using 

the Pan tool, you will still be able to see the design in the 

window. Note that the pan tool does not actually move parts of 

the design around, just your view of them.

Taking Measurements

The Ruler  tool lets you measure the distance between any 

two points in your design workspace. When you measure from 

one point to another, the distance is displayed in the status line 

located at the bottom of the window. The status line shows the 

horizontal and vertical distances the Ruler tool travels from the 

x and y axes, the angle measured, and the total distances.

To measure Designs:

1 On the Ribbon, select the Home tab.

2 Click on the Ruler  tool.

Your pointer changes to a ruler when in the Design 
Workspace.

3 Click and drag your mouse until you are finished measuring 

the item. 

4 Let go of your mouse when you are finished measuring. 

5 Look in the status line at the bottom of the workspace to see 

the measurement.

6 Right-click to set the end point of your measurement.

The measurement is now displayed in the status bar.

You can right-click to switch back to whichever tool you were 
using before you selected the Pan tool.

The ruler measurements are calculated in the units you set 
under the Units tab of the Preferences dialog.
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Displaying the Hoop
Viewing the hoop or frame on the screen lets you ensure that 

your design fits properly when you run it on the machine. The 

hoop serves as a guide to help size and position your design in 

the design window. Pacesetter BES Monogramming Suite 

comes with many pre-loaded hoop sizes.

Viewing and Hiding the Hoop

Use the Hoop  tool to show and hide the hoop in the display 

window. Just click on the Hoop tool to show the hoop (if it is not 

currently shown) and click it again to hide the hoop.

Selecting a Hoop
You can select one of the pre-loaded hoops using the Hoops 

dialog. You will notice that you can select hoops from different 

file types in this dialog. This is useful when you want to make 

sure that your design will fit for more than one kind of 

embroidery machine.

To select a hoop using the Hoops dialog:

1 On the Home Tab, click the down arrow under the Hoop tool.

2 From the menu that appears, click on Select Hoop. 

You see the Hoops dialog.

The hoop’s dimensions are determined by your settings under 
the Hoops dialog in Pacesetter BES Monogramming Suite.

Using the Hoop tool may effect the magnification level of your 
design. For example, if you are zoomed in on the design, 
clicking the Hoop tool will cause the view to zoom out enough to 
fit the entire hoop into the workspace.
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3 Select the machine format from the drop-down list at the top 

of the dialog.

4 From the list of Hoops, choose a hoop size appropriate for 

your design.

5 If needed, check the “Rotate 90” box to make the hoop fit 

your design better.

6 Click OK.

Scaling a design to fill the hoop
The Fit Hoop automatically scales the current design to fill the 

maximum size of a current hoop. This feature recalculates 

stitches where necessary.

To scale designs to fill hoops:

1 Open an existing design. 

If you choose the PES format, you will see that there is an 
option to select “MultiNeedle” hoops. This applies only if you 
have a MultiNeedle embroidery machine.

If you check this box, the list of hoop formats will change to a 
list of hoops that are used with a MultiNeedle machine.
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2 On the Home Tab, click the down arrow under the Hoop tool.

3 From the menu that appears, click on Fit Hoop. 

The current design will automatically be resized to fill the 
current hoop.

Available Hoops
Pacesetter Monogramming comes pre-loaded with a number of 

different hoops. The hoop sizes available for each file type are 

listed in the following table.

Format Available Sizes (mm)

DST 130 × 180, 300 × 300

EXP 130 × 180, 300 × 300

HUS 100 × 100, 80 × 80

JEF 240×200, 200 × 200, 140 × 200, 126 × 110, 50 × 50

PCS 120 × 115, 80 × 80

PES 300 × 200, 180 × 300, 160 × 260, 200 × 200, 130 × 180, 
100 × 180, 130 × 60, 130 × 50, 100 × 100, 90 × 80, 
60 × 40, 60 × 20 

PES Multi-
needle

360 × 200, 300 × 200, 300 × 100, 160 × 160, 130 × 130, 
100 × 100

SEW 122 × 88, 80 × 70, 50 × 50

SHV 150 × 240, 100 × 100, 40 × 40

VP3 & VIP 360 × 350, 360 × 200, 150 × 240, 140 × 225, 170×100, 
120 × 120, 100 × 100

XXX 130 × 240, 114 × 114, 112 × 80, 55 × 55

Important: The maximum size of the design that you can save, 
in any given file format, is limited by the largest hoop available 
in that format. 
For example, if you are saving as PES MultiNeedle, the largest 
design you will be able to save is 360mm × 200mm.

If you try to save a file that is larger than the largest hoop, you 
will be given an error message.
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Getting Help
The Pacesetter BES Monogramming Suite Help is a quick way 
to find answers to your questions and see step-by-step 
instructions. Because a large number of topics exists, the Help 
allows you to search for topics in various ways. You can search 
using the table of contents, the index or a database of 
keywords. You can also save the topics you visit most often.

Opening the Help

To open the Help:

1 Double-click the Pacesetter BES Monogramming Suite icon 

on your desktop.

2  Click the Help  tool.

You see the Help. 

Using the Contents
The Help has a table of contents, with a list of book icons. Each 

book contains a series of related topics. 

To use the Contents: 

1 Click the Help  tool.

You see the Help. 

2 Double-click the book you want to open. 

3 Click the topic you want to see.

You see the topic in the right pane.

Using the Index 
The Help index is similar to the index in a book. 

To use the Index:

1 Click the Help  tool.

The help is also available in document form (.PDF) on your 
Installation CD.
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You see the Help. 

2 In the box, enter the word or words you want to search for.

In the list, you see the topics that most closely match your 
query. 

3 Click the term you want to learn more about.

If there is more than one topic for the keyword, you see a 
menu. 

4 Click the topic you want to see. 

You see the topic in the right window pane.

Using Search
The Search tab lets you search using keywords or phrases in a 

database of all the words found in the Pacesetter BES 

Monogramming Suite Help. 

To use Search:

1 Click the Help  tool.

You see the Help. 

2 Select the Search tab. 

3 In the ”Keyword” box, enter the word or phrase that you are 

searching for.

4 Click the List Topics button.

In the list below, you see the topics that contain the words 
you searched for. 

5 Click the topic you want to view, and then click Display. 

You see the topic in the right window pane.

Saving Favorite Help Topics
The Favorites tab lets you save the topics that you visit most 

often and want to access quickly.

To save your favorite topics:

1 Click the Help  tool.

You see the Help. 
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2 Double-click the book you want to open. 

3 Click the topic you want to save as your favorite.

You see the topic in the right window pane.

4 Click the Favorites tab.

You see the selected topic in the Current topic area.

5 To add the selected topic to your favorites list, click Add.

You see the selected topic appear in the Topics area.

6 To display your favorite topic, do one of the following:

 In the Topics area, select the favorite topic you want to 
display and click Display.

 In the Topics area, double-click the favorite topic you 
want to display.

You see the topic in the right window pane.

7 To remove one of your favorite topics, do the following:

 In the Topics area, select the favorite topic you want to 
remove and click Remove.

Printing Help topics
You can print any of the topics in the Help. 

To print topics:

1 Click the Help  tool.

2 Click the topic you want to print.

The topic will appear in the Help window.

3 Click Print.

You see the Print Topics dialog box. 

4 Select one of the following print options:

 Print the selected topic

 Print the selected heading and all subtopics

5 Click OK.

You see the Print dialog box.

6 Change any of the print settings, if necessary, and click OK.

The topic will be sent to your printer.



The Monogram Designer dialog is the main creative tool of 

Pacesetter BES Monogramming Suite. It allows you to quickly 

create complete monogram embroidery designs, with 

decorations and frames. You can also determine the color and 

font of the letters in the monogram.

Topics covered in this chapter:

• How to create a monogram design

• Adding decors and frames to the monogram

• Changing colors of letters in a monogram

• Saving a monogram design as a template

• Using the Add Frames and Add Design tools

• Merging other designs with your monogram

CHAPTER 2:

Creating & Decorating 
Monograms
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Using the Monogram Designer 
Dialog
You create your Monogram designs using the Monogram 

Designer dialog. Open this dialog by clicking the Monogram 

Designer button on the Home tab of the ribbon. To close the 

Monogram Designer dialog, click the OK button to generate the 

design, or the Cancel button to return to the main workspace 

without adding a new monogram.

Layout of the Monogram Designer 
Dialog
There are several different areas of the dialog with different 

functions. The following illustration identifies the parts of the 

dialog; these terms will be used throughout the instructional 

sections that follow.

Schematic guide to the parts of the Monogram Designer dialog: A= 
Monogram styles area, B= Preview panel, C= Text area, D= Color change 
swatches, E= Font area, F= Height field, G= Status bars, H= Template 
buttons 
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Creating a Monogram
Creating a simple monogram design is very easy with 

Pacesetter BES Monogramming Suite. Simply select one of the 

monogram layouts, type in the letters you want, choose a font 

and thread color, and click the OK button. The basic monogram 

will appear in your workspace, after which, you can save it to 

the appropriate file type.

You can also add embellishments to the monogram using the 

“Monogram Designer” dialog. For details, see the following 

sections, “Adding Decors to a Monogram” and “Adding a Frame 

to a Monogram”.

To create a new monogram design:

1 In the Monogram Designer dialog, select one of the styles 

from the monogram styles area.

2 In the Text area, type your lettering into the appropriate text 

field.

3 Select the Font for the monogram from the fonts field.

The number of text fields that are “active” depends on the 
monogram style you have chosen. 
For a single-letter monogram pattern, only the Text1 field will 
be active; if a two-letter style is chosen, ’Text 1’ and ’Text 2’ will 
be active; and if a three-letter style is selected, all three fields 
will be available.

For Name-type templates, both the ’Text 1’ and ’Text 2’ fields 
will be active - the initial letter will be input into ’Text 1’ and the 
name portion will be input into ’Text 2’. The exception to this is 
the “Name-only” (i.e. no initial) template. For this template type, 
the text for the name will be entered in the ’Text 1’ Field. 

Also note that, for the Name template monogram styles, the 
maximum number of characters that the name field can have is 
30.
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4 If desired, change the height of the font by typing a new 

value into the Font Height field of the dialog.

5 By default, the monogram lettering will be generated with a 

satin fill; however, you can change to a pattern fill by 

checking the Pattern Fill box in the dialog.

6 Add Decors and/or a Frame, if desired.

For more details on adding Decors and Frames, see the 
corresponding sections, below.

7 Click Apply to see your changes in the preview panel.

8 When all your changes have been made, click OK.

The design appears in the workspace.

For “Name Template” monogram styles, there will be two 
Height fields - ‘Font 1 Height’ to change the height of the 
monogram lettering, and ‘Font 2 Height’ to change the height of 
the name.

Again, there is an exception for the “Name only” style - in this 
case the height of the name will be controlled by the ‘Font 2 
Height’ field.

Each font has maximum and minimum recommended heights; 
for best quality on sew-out, you should stay within these limits.

If you enter a font height that is outside of the recommended 
range, a warning dialog will appear when you click the Apply 
button. This dialog will advise you to change (increase or 
decrease, depending on weather you are below the minimum 
or above the maximum) the font height until it is within the 
recommended range for that font. 

For “Name Template” monogram styles, there will be two 
Pattern fill checkboxes active in the dialog; check Font 1 Pattern 
Fill to change the monogram lettering to a pattern fill, and Font 2 
Pattern Fill to change the “name” portion to a pattern fill.

If the “Name only” template type is being applied, the Font 1 
Pattern Fill box will apply to the “name” text.
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Viewing the Design Actual Size
By default, the design preview in the Monogram Designer dialog 

will be scaled such that it fills the entire preview panel. This 

means that the apparent size of the lettering will change as you 

add or remove frames or decors. 

If you want the preview panel to display the design actual size 

instead, check the “1:1” box at the bottom of the Monogram 

Designer dialog. The size of the design in the preview panel will 

be based on the lettering height chosen, and will not change 

when decors and/or frames are added or removed.

Changing the thread color in a 
Monogram
In the Monogram Designer dialog, the lettering will have a 

default color to start out with. Using the Import Color function, 

you can change this color to whatever suits you, based on a list 

of manufacturers’ thread color tables. The Import color function 

can be applied to each letter in the monogram separately, 

should you want to have your letters sewn in different colors.

To change the color of letters in the Monogram:

1 To the right of each letter, in the text area of the dialog, there 

is a colored square (the “color swatch”) - this shows the 

current thread color. Click in this square.

You see the Import Color dialog.

Note that the actual size of monogram - width and height - will 
always be displayed in the lower-left corner of the Monogram 
designer dialog.
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2 Select a new color palette (if desired) by clicking the down 

arrow to the right of the Color Palette Name list.

The new list of thread colors appears in the dialog.

3 Choose a thread color from the selected palette by clicking 

one of them.

4 Click Select.

The Import Color dialog closes, and the swatch changes to 
the color you have selected

5 On the Monogram Designer dialog, click Apply.

In the Preview panel, the letter will change to the color you 
chose.

You can search for a particular color within the Color Palette 
you have chosen, if you know its name.

To do this, click the find  button in the Import Color dialog. 
This opens another small dialog, the Find Color dialog. Type 
the first few letters of the name of the color you are looking for 
into the box, and the Find dialog will display a list of colors that 
match those initial letters. Alternatively, you can type in the 
thread number (if you know it), and the Color Find tool will 
locate the thread by number. Then, click the color you want in 
the list; this will select that color in the Palette.
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Changing the Font
You can also change the font of the monogram lettering in the 

Monogram Designer dialog. Use any one of a large selection of 

digitized embroidery fonts that come with the Pacesetter BES 

Monogramming Suite embroidery software.

To change the font:

1 In the Font area, click on the down-arrow next to the Font 1 

list.

A drop-down list of all the available fonts appears. As you 
“hover” the mouse pointer over each font’s name, you see a 
sample of the highlighted font.

2 On the drop-down list, select the desired font by clicking on 

it.

3 Click Apply.

The monogram lettering changes to the selected font.

Note: Name Template Monogram Styles

For the Name Template monogram styles, there are two 

separate lettering segments – the single-letter monogram in the 

background, and the multi-letter text in the foreground. 

For these styles, it is possible to choose a different font for each 

part of the text; the ‘Font 1’ box determines the font of the single 

letter, and the ‘Font 2’ box determines the font of the multi-letter 

part. Choose your second font in exactly the same way as 

outlined above for changing ‘Font 1’.
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Also, in the case of the Name Template monograms, two 

different Letter height boxes will be active, so that the font 

height for the “name” part may be set separately from the font 

height for the monogram itself.

Similarly, there will be two separate “Pattern fill” checkboxes; 

check Pattern Fill1 to add a pattern to the monogram, and 

Pattern Fill 2 to add it to the “name” portion.

An example of a Name Template style, to demonstrate the use of two 
different fonts. In this example, “Venezia” was selected for Font 1, and 
“Calligraphy” was selected for Font 2.

Displaying a Font’s Available 
Characters
In the Monogram Designer dialog there is a button next to each 

of the font fields which displays all the characters (keystrokes) 

that can be entered for the selected embroidery font. For 

example, some fonts only allow you to enter uppercase 

characters, while other fonts allow you to enter both uppercase 

and lowercase characters. 

The available characters box also tells you the minimum and 

maximum recommended heights for sewing out the font.

The “Name only” template type is an exception to these rules: 
for this template, only the Text 1, Font 1, Font 1 Height and 
Font 1 pattern fill boxes will be active, and these will apply to 
the “Name” text. 
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To display a font’s available keystrokes:

1 Open the Monogram Designer dialog. 

2 In the Font1 or Font2 field, select the desired font from the 

drop-down list. 

3 Click on the available characters button  to the 

immediate right of the font field.

You see a window that displays all the available keystrokes 
that you can enter for the selected font.

4 Click the OK button to dismiss the available characters 

dialog.

Applying “Right-side” characters
A few of the Pacesetter BES Monogramming Suite fonts contain 

special characters, which have been digitized to fit on the right 

side of monograms. These are the Circle, Decor Style, and 

Script Style fonts. 

In these fonts, the upper-case keystrokes (A, B, C...) produce 

capital letters that slope up from left to right, and the lower-case 

keystrokes (a, b, c...) produce capital letters that slope down 

from left to right. Combining the two types of letters gives a 

proper shape to monograms created using these fonts.
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For example, in the Decor Style font, the letter A will look like 

this:

While, in contrast, the letter a looks like this:

Therefore, to make a “balanced” two-letter monogram, you 

would type the upper-case letter in the Text 1 field, and the 

lower-case letter in the Text 2 field.

Below are two examples of completed two-letter monograms 

using upper- and lower-case keystrokes in combination.

“Aa” (Decor Style) “Aa” (Script Style)



Creating & Decorating Monograms 43

Adding Decors to a Monogram
In the Monogram Designer dialog, you can add small decorative 

designs, called decors, to embellish your Monogram. There are 

eight possible positions where you can place decors in the 

dialog preview panel; these are indicated by the small 

placeholder graphics, which look like this: .

To add Decors to your Monogram:

1 Click on the placeholder position where you wish to place 

the first decor.

The column on the right of the dialog changes to show a list 
of available decors.

2 Click on the decor you want to add.

The selected decor appears in the monogram preview panel.

3 Adjust the decor by doing the following (these are optional):

 Change the size of the decor by typing a percentage into 
the scale box.

Note that both Decors and Frames can be added to the same 
Monogram design.
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 Check the Flip horizontal box.

 Check the Flip vertical box.

4 Repeat steps 1–3 to add more decors in the other positions.

5 When you have added all the decors required, click OK.

The completed design appears in the workspace.

Note: Monogram Designer Preview

The arrangement of lettering and frames in a design will be 

affected by any decors that are placed into it. When the 

monogram is generated, it will be centered and will fit tightly 

within the frame, ignoring any “unused” decor positions.

This will be relevant if, for example, a decor is placed on one 

side of the monogram, and not on the other. In such a case, the 

preview in the Monogram Designer will not look exactly the 

same as when it is generated in the main Workspace window, 

since it is still taking into account the decor placeholders.

So, in order to preview the design as it will generate, place the 

decors you want, and then uncheck the Decors box. This will 

remove any unused placeholders, and change the preview to 

show all the elements of the design correctly arranged. 

You can also make these changes - that is, flip or scale the 
individual decors - after you have added all the desired decors 
to the preview of the monogram. Do this by selecting them 

individually with the Select  tool.

If you want to add the same decor design more than once, 
select and place first decor as described above. Then, hold 
down the CTRL key while clicking the next placeholder; the 
Monogram Designer will retain your original selection and 
apply it to all subsequent placements.

You can also check the 1:1 box to show the lettering, frames 
and decors in actual size.
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Above, a the preview of a design with the “Decors” box checked; below, the 
same design with the box unchecked. Note how the letters in the monogram 
have shifted up and to the right (relative to the frame), because the decors 
placeholders have been removed. This correctly reflects the actual 
arrangement of the design objects when stitches are generated.
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Adding a Frame to the Monogram
You can enhance your monogram design by adding a 

decorative frame to it. Select the frame from a long list of 

embroidery designs that are included with the Pacesetter BES 

Monogramming Suite software. You will see previews of these 

frames in the pane on the right side of the Monogram Designer 

dialog.

To add a frame to the monogram design:

1 In the preview panel of the Monogram Designer dialog, click 

on the Frame placeholder to select it.

 The list of available frames appears in the column to 
the right of the dialog.

2 Click on one of the frames to select it.

The selected frame will appear in the preview panel of the 
dialog. If you wish, you can click through a number of 
different frames to preview them.

Note that both Decors and Frames can be added to the same 
Monogram design.
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3 Click OK to create the design.

The Monogram, with the selected Frame added, will now 
appear in the Pacesetter BES Monogramming Suite design 
workspace.

Monogram Templates

Saving a Monogram Template
The “Save Template” option is very useful if you are going to be 

creating a number of designs that are very similar; for example, 

if you are going to make some designs that have exactly the 

same pattern of decors, but with different people’s initials in the 

middle. You can select the monogram style, font, decors, and 

frame, and then save this pattern as a template, for later re-use. 

Then, when you want to make a new monogram, you can open 

the template and change only the letters.

To save as a template.

1 Open the Monogram Designer dialog.

2 Create a new monogram design as usual, but do not press 

OK when you are finished.

3 Select the “Save Template” button.

You see a “Save as” dialog box.

4 In the “Save as” dialog, choose a destination folder for the 

template, and type a name in the File name field.

5 Click Save.

Applying a Monogram Template
When you want to use one of your saved templates in 

Monogram Designer, do the following.

To use a monogram template:

1 Open the Monogram Designer dialog.

2 Click the Open Template button.

You see an Open dialog.
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3 In the “Look in” field, navigate to the folder containing your 

saved templates.

4 Choose a template, and click “Open”

The template opens in the Monogram Designer dialog.

5 Make any necessary alterations to the design, for example, 

the initials in the monogram, the color of the letters, etc.

6 Click OK.

The new design appears in your workspace.

Merging Files
Pacesetter BES Monogramming Suite allows you to merge 

embroidery files into your current file.

This allows you to use other designs (such as pre-digitized 

stitch files) in a design and add Monogram lettering to it. 

When you merge a *.BRF file into the design window, your 

single design file contains both outlines and stitches. When you 

merge any other kind of file into the design window, the merged 

segments open as stitch segments.

To merge an embroidery file into a design:

1 Do one of the following:

 Open an existing file.

 Create a new design.

The original design appears in the workspace.

2 Click the Merge tool.

You see the Merge Design dialog.

3 In the Look in list, browse to the location of the file you want 

to merge.

4 In the Files of type list, select a design file type for the 

design you want to merge.

5 In the File Name box, select the design file that you want to 

merge onto the current open design workspace.
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6 To view a preview of the selected design, click the “Preview” 

checkbox, if not already selected.

You see a preview image of the selected design appear on 
the right-hand side of the dialog.

7 Click Open.

The merged design file will appear in the design workspace.
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Topics covered in this chapter:

• Selecting objects (lettering, frames, or decors)

• Copying, cutting and pasting objects in the design.

• Grouping and ungrouping objects in the workspace.

• Using the selection handles of an object to resize or rotate it.

• Selection of thread colors and thread palettes.

• Using the Color Sort tool to reduce the number of thread 

changes required during sew-out.

• Printing Design Worksheets, and changing print settings.

CHAPTER 3:

Editing Designs
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Editing Monogram Designs
Once you have finished placing your Monogram design in the 

design workspace, you may want to change or rearrange it in 

various ways. You may, for example, wish to move parts of the 

design around, or change the orientation of one of the decors. 

Using the various tools and methods outlined in this chapter, 

you can select, move, rotate, and otherwise modify parts of the 

design. First, however, it is necessary to select the part of the 

design you wish to modify - this is covered in the next section.

Selecting Design Object
The Select  tool allows you to select and modify individual 

objects or groups of objects. You select these objects by 

clicking on one of them, or by clicking and dragging to draw a 

box around parts of the design.

To select segments with the Select tool:

1 On the ribbon, click the Select  tool.

2 To select one segment, do one of the following:

 Click the object you want to select.

 Click and drag to select the object you want.

The active object is enclosed in a selection box with handles. 

3 To select multiple segments, do one of the following:

 Click and drag across all the segments you want to 
select.

 Click a segment. Press CTRL on your keyboard while 
you click each segment not already selected.

The active segments are enclosed in a selection box with 
handles.

You can also select objects in the design by clicking on them in 
the Sequence view. Note however, that in the Sequence view, 
the embroidery segments are grouped by color, so you can 
only select whole color groups. 
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Copying Segments
In the Pacesetter BES Monogramming Suite design workspace, 

you can use the copy (or cut) method to place segments of your 

design onto the computer’s clipboard. You can then use these 

cut or copied design objects elsewhere in the design, by pasting 

them back into the workspace, with the Paste command. This is 

a way to quickly create a repeated motif.

To copy to the Clipboard:

1 Select one or more segments you want to copy.

2 To copy segments to the clipboard, complete the following:

 In the clipboard area of the Home tab, click Copy.

 In the design workspace, right-click the segment(s) and 
choose Copy from the menu.

 Press Ctrl+C on your keyboard

The segments will be copied, but not removed from their 
original placement in the design.

To cut to the Clipboard:

1 Select one or more segments you want to cut.

2 To cut segments to the clipboard, complete the following:

 In the clipboard area of the Home tab, click Cut.

 In the design workspace, right-click the segment and 
choose Cut from the menu.

 Press Ctrl+X on your keyboard 

The segments are removed from their placement.

To paste a design object into the current design:

• Do one of the following:

 In the clipboard area of the Home tab, click Paste.

 Right-click, and choose Paste from the context menu.

 Press Ctrl+V on your keyboard.

The object you cut or copied will be pasted into your design.

When you paste an object into the design, it will be placed at 
the end of the sequence, and therefore will sew out last. The 
pasted segment (or segments) can be re-ordered in the 
Sequence View.
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Deleting Segments
Deleting an object removes it from the design. The only way to 

retrieve an object you delete is to use the Undo button 

immediately after you delete it.

To delete a segment:

1 Select a design object, or set of objects.

2 Do one of the following:

 Press Delete on your keyboard.

 Right-click the segment, and select Delete from the 
menu.

Grouping and Ungrouping Objects in 
a Design
You can combine several segments into a group so that the 

segments are treated as a single unit. When they are grouped, 

you are able to make changes to the group as a whole, while 

leaving other parts of the design unchanged. Segments must be 

selected in order to group them. 

To group segments:

1 In the design workspace or Sequence View, select the 

segments you want to group.

2 The selected objects will be enclosed in a selection box.

3 Right-click, and select “Group” from the context menu.

You can now edit the group as a whole.

To ungroup segments:

1 In the design workspace or Sequence View area, select the 

grouped segments.

2 Do one of the following:

3 Right-click, and select “Ungroup” from the context menu.

The objects will no longer be grouped together.
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Reflecting a Design Object
Reflecting an object flips the object across an invisible axis. You 

can choose either a vertical or horizontal axis to reflect across.

To reflect segments:

1 Select the segment(s) you want to reflect.

2 From the arrange tool bar, click one of the following:

 Click the Flip Vertical  tool to flip selected objects 

vertically.

 Click the Flip Horizontal  tool to flip selected objects 

horizontally.

On the left, the original design object; on the right, the same object copied, 
and then reflected with the Horizontal Flip tool. 

Aligning parts of the Design
You can align lettering or objects horizontally or vertically. You 

can use this feature to precisely align any objects of a design.

To align segments:

1 Select the segments you want to align.

2 From the Arrange tab on the Ribbon, click any of the 

following:
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Resizing Design Objects
Resizing an object enlarges or reduce its dimensions. You can 

change the size of an design component using the handles on 

the sides of the object’s selection frame. Depending on which 

frame handle you chose, you can resize it horizontally, 

vertically, or proportionally.

Resizing a decor object proportionally by clicking and dragging. The outline 
shows the size the object will be when the mouse button is released.

To resize parts of the design using the frame handles:

1 Select one or more segments.

The active segment(s) is enclosed in a selection box with 
handles.

Vertical Center: Takes all selected objects and centers them 
in the selection box. The objects are moved so that they are 
centered top-to-bottom with each other, but they are not 
moved left or right.
Horizontal Center: Takes all selected objects and centers 
them in the selection box. The objects are moved so that they 
are centered left-to-right with each other, but they are not 
moved up or down.

Center: Centers one or more selected objects in the active 
hoop.
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2 Do one or more of the following to resize segment(s):

 To resize the segment’s width, click and drag the 
handles located on the left and right of the selection box.

 To resize the segment by height, click and drag the 
handles on the top and bottom of the selection box.

 To resize segment(s) proportionally, click and drag the 
handles located at the top or bottom corners of the 
selection box.

Rotating Segments
You can rotate a design object manually by clicking and 

dragging the selection’s rotation handle.

Rotating a segment

To rotate segments:

1 Select one or more segments you want to rotate.

The active segment(s) is enclosed in a selection box with 
handles.

2 Move your mouse over the blue rotation bead beside the top, 

right or the bottom left design handle.

You will see the cursor change to a circular arrow .
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3 Click and drag the rotation bead to adjust the box to the 

angle you want.

Moving Parts of the Design
There are a couple of ways to move objects in your design 

around relative to one another.

Moving Segments Manually

You can move segments around your design by dragging them 

to another location.

To move an object or a copy of an object manually:

1 On the Ribbon, click the Select  tool.

2 Select the objects, or group of objects.

The object you have selected will be enclosed in a selection 
box, with handles.

3 Click on the “x” in the center of the selection box, and drag 

the object or group to its new location. 

As you drag, the status line displays the horizontal (dx) and 
vertical (dy) distance.

Nudging Segments

Nudging moves the selected object or group of segments, a 

very small distance at a time. Nudging is similar to dragging the 

object but the distance that the object moves is smaller, giving 

you finer control. 

To nudge an object or group of segments, select it and then 

press the Ctrl key plus one of the up, down, left or right arrows 

on your keyboard.

The angle you have rotated the object will be shown (in degrees) 
on the status line, in the bottom-left corner of the workspace.
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The Properties Panel
By default, the Properties Panel appears on the right of the 

workspace. This panel displays, and allows you to modify, all 

the properties associated with the letters in your designs. These 

properties include text properties, fill properties, underlay 

properties, and pull-compensation properties.

Each of these types of properties has its own section in the 

Properties Panel, and each will be discussed in detail in its own 

section to follow.

Adjusting Text Properties
The Properties Panel appears as a panel on the right side of the 

Pacesetter BES Monogramming Suite workspace. When a 

monogram is selected, you will be able to change certain 

properties of the text segment. These include Height of the 

letters in the monogram, the width percentage and the slant. 

You can also determine how lock stitches and trims will be 

applied to the segment, for those machine formats that support 

the trim command.

Changing the Height of Lettering
It is easy to change the height of your text. Height refers to the 

tallest character in the desired lettering. So, when a text 

segment contains both uppercase and lowercase letters, it is 

the size of largest uppercase letters that is set by this property.

Settings in the Properties Panel only apply to monogram text 
objects, not to other designs that are added to the monogram 
(such as decors and frames).

If you need to make room in the Properties Panel in order to 
see some of the fields better, you can collapse one or more 
areas by clicking the small minus sign next to its name; the box 
will then display a small plus sign. Clicking on the plus sign 
expands that area again. 
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To change the height of lettering:

1 Select the text object you want to alter.

2 In the Text area of the Properties panel, select the Height 

field.

The property label (Height) is highlighted in blue. 

3 Type in the height you want your letters to be.

4 Click Apply to save your changes.

You see your text’s height altered accordingly.

Width Percentage
The Width Percentage changes the overall width of a text 

segment. You can adjust the Width percentage to alter the 

appearance of the text object, or to allow it to fit the hoop better.

To change width percentage:

1 Select the text object(s) you want to alter.

2 In the Text area of the Properties panel, select the Width 

field.

3 Enter the width percentage value you want to use.

4 Click Apply to save your changes.

You see your text’s width percentage altered accordingly.

Slant
Pacesetter BES Monogramming Suite allows you to use the 

Slant setting to create a slanted effect in lettering. Slant 

changes the degree value of the slant on your lettering. A 

negative value slants your lettering to the left; a positive value 

slants it to the right.
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Positive slant of 20 above, negative slant of 20 below.

To change slant settings:

1 Select the text object(s) that you want to alter.

2 In the Text area of the Properties panel, select the Slant 

field.

3 Enter the slant value you want to use. To slant your lettering 

to the left, enter a negative value. To slant your lettering to 

the right, enter a positive value.

4 Click Apply to save your changes.

You see your text altered accordingly.

Trim Settings
Use the Trims field of the Properties Panel to control how trims 

are applied to lettering segments.

You can choose from the following options:

• Always: Inserts a trim between all letters in the segment.

• Never: No trims are placed between letters in the segment

• Auto: A trim is placed between the letters, if the distance 
between them exceeds a certain set value.

Note that not all machine format support trims. If you save your 
design in a format that does not support trims, the trim will not 
occur on your machine during sew-out.
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Lock Stitches
You can choose to add lock stitches to the lettering using the 

Lock Type field in the properties panel. The options are:

• Always 

• Never

• Around trim

Fill Density Setting
The density of monogram lettering can be changed in the 

Properties panel. Fill density is the distance between individual 

lines of embroidery, and is measured in millimeters.

Use the density setting to adjust your fill to suit the fabric you 

are sewing on. For example, fabrics with a very loose weave are 

less able to hold a large density of stitches; in cases such as 

this, you can lower the density of the fill. If you are unsure what 

setting to use, try the standard setting of 0.4. This setting works 

well almost universally, as long as you have not exceeded the 

font’s size recommendations.

In the Fill area, you will see that the image beneath the density 

setting changes as you adjust it. These are not precise images; 

rather, they are intended to provide you with visual cues to what 

you are doing as you change the settings.

Note that, in Pacesetter BES Monogramming Suite, the fill 
density can only be adjusted for monogram lettering; you 
cannot change the fill density of other embroidery objects, such 
as Decors and Frames.

Density is given in millimeters; larger values correspond to a 
lower density, while lower values correspond to a higher 
density.
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Underlay Settings
Underlay stitches are laid down before the visible, or “top” 

stitches, to help stabilize stretchy fabrics. They can also help to 

tack down wales or naps (on fabrics such as corduroy).

There are a variety of possible underlay types available; the 

following image gives a schematic view of how the different 

types of underlay are sewn.

Selecting the Underlay Type
You can select underlay types for various types of stitches. 

Choose from Contour, Perpendicular, Parallel, or Zig-Zag. You 

can combine underlay types to get maximum coverage. 

To select an underlay type:

1 Select the monogram segment.

2 In the Properties Panel, scroll down to the Underlay area.

3 Select one or more of the following underlay types you want 

to use: Contour, Perpendicular, Parallel, or Zig-Zag.

Note that, in Pacesetter BES Monogramming Suite, Underlay 
can only be added to monogram lettering; it cannot be applied 
to other embroidery objects, such as Decors and Frames.
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4 Adjust any of the other settings. Refer to the related 

procedures for more information.

5 Click Apply.

Specifying the Underlay Density
You can specify the density for underlay stitches in the 

Properties Panel.

To set the underlay density:

1 Select the monogram segment.

2 In the Properties Panel, scroll down to the Underlay area.

3 Select one or more of the following underlay types you want 

to use: Contour, Perpendicular, Parallel, or Zig-Zag

4 In the Density box, enter a density value.

5 Adjust any of the other settings. Refer to the related 

procedures for more information.

6 Click Apply.

Specifying the Underlay Stitch 
Length
You can specify the stitch length for your underlay stitches. You 

can increase or decrease the length according to your underlay 

needs. 

To specify the underlay stitch length:

1 Select the monogram segment.

2 In the Properties Panel, scroll down to the Underlay area.

3 Select one or more of the following underlay types you want 

to use: Contour, Perpendicular, Parallel, or Zig-Zag

When you select underlay types, you will be able to see what 
your underlay type will look like in the Preview area.

When you select underlay types, you will be able to see what 
your underlay type will look like in the Preview area.



Editing Designs 65

4 In the Stitch Length box, enter the stitch length that you want 

for your underlay stitches. 

5 Adjust any of the other settings. Refer to the related 

procedures for more information.

6 Click Apply.

Inset Distance for Underlay
You can change the inset distance. Pacesetter calculates the 

inset distance (the distance the underlay stitches are placed 

from the edge of the top stitching.) 

Inset distance changes the amount of underlay coverage. The 

smaller the inset distance, the more coverage you have.

To change the inset distance:

1 Select the monogram segment.

2 In the Properties Panel, scroll down to the Underlay area.

3 Select one or more of the following underlay types you want 

to use: Contour, Perpendicular, Parallel, or Zig-Zag

4 In the Inset box, enter the amount of distance you want. 

Enter a zero value if you want to place the underlay directly 
on the edge of the monogram segment.

5 Click Apply.

When you select underlay types, you will be able to see what 
your underlay type will look like in the Preview area.
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Pull Compensation Settings
Pacesetter BES Monogramming Suite allows you to adjust the 

pull compensation in your design. In the Properties panel, you 

can use the settings available in the Pull Compensation area to 

adjust the pull compensation of text objects.

There are two types of pull-compensation, which differ in the 

way that the pull compensation is determined. 

• A percentage pull-compensation calculates the change 
made to the stitches’ width based on their original width. 

• An absolute pull compensation is simply an extra amount of 
width which is added to the stitches regardless of their 
original length.

To adjust the pull compensation:

1 Select the monogram lettering you want to adjust.

2 Press ALT + Enter to display the Properties panel.

You see the Properties panel.

3 In the Pull Compensation Area of the Properties panel, click 

the down arrow to the right of the Type field.

4 A list of options is displayed; select one of the following:

 None. Makes no adjustments to pull compensation.

 Percentage. Enter the percentage in the Value % box 
and, if necessary, enter the maximum value of pull-
compensation in the Max Range box.

 Absolute. Enter the amount of absolute pull-
compensation (in mm) in the Absolute Value box.

5 Click Apply.

Note that pull compensation can only be applied to monogram 
lettering; it cannot be applied to other embroidery objects, such 
as Decors and Frames.

When you use percentage pull-compensation, you can also 
enter a value in the Max range box of the Pull Compensation 
area. This value sets an absolute maximum limit on the size of 
the pull compensation. If the calculated pull compensation 
value goes over this length, the actual stitches that are 
generated will be limited to this length.
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Working with the Color Palette
In Pacesetter BES Monogramming Suite, you can change the 

color of any component of your design, whether it is the letters 

in a monogram, part of a frame, or one of the decor segments. 

Essentially, if you can select it, you can change its color.

The color palette, located along the top of the workspace, 

shows you the thread colors that are available in the thread 

chart that is currently selected.

Selecting a Thread Chart
Pacesetter Monogramming comes with a large number of the 

most popular manufacturers’ thread charts already loaded. You 

are able choose from amongst these charts by clicking on the 

Thread Chart button , which is on the left end of the Color 

palette. If you click this button, you will see a list of all the 

available thread charts. Click on the one that you want, and 

those thread colors will be loaded into the color palette.

Searching for a Specific Color

The Find Color button , located near the left end of the 

thread palette, allows you to search for a particular thread in the 

palette, if you know the name or thread number.

To search for a thread color: 

1 Click the Find Color  button. 

You see the Find Color dialog.
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2 Type in all or part of the name or number of the thread.

3 When you have found the color you want, click to select it.

4 Click the Find button.

The color you were looking for will now be the selected color 
in the palette.

Changing a Thread Color
Pacesetter Monogramming allows you to adjust the colors of the 

lettering you create, or indeed any component of the design, by 

using the Color Palette; you do this by choosing thread objects 

in the Color palette.

To change thread colors:

1 Do one of the following.

 With the Select tool, select an object in the workspace.

 In the Sequence view, click on a segment.

2 In the Color Palette, click the color box with the thread color 

you want to use.

If you only know part of the thread name, and there is more 
than one possible match for that partial name, the search 
dialog will present you with a number of choices (as in the 
example below).

This also applies to thread palettes that are numbered; you can 
type in the first few digits of the thread’s number, and the Find 
Color dialog will display a list of matching numbers. 

If you hover over a color square on the Palette, the thread 
manufacturer, the thread name, and number will show beside 
the mouse pointer.
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Working with Sequence View
Sequence view is a list of color groupings in a design. Design 

segments that are the same color, and are sewn in sequence, 

will be grouped together in the Sequence View. 

You can select the individual color groups of your design from 

within the Sequence View. One of the advantages of this is to 

make it easy to change thread colors in your design quickly.

See “Changing Thread Colors in the Sequence View”, below.

Selecting a color group in the Sequence View panel

You can also use the sequence view to change the order of the 

sewing of color groups in a design. You do this by selecting a 

color group and moving it up or down in the sequence view 

panel (corresponding to earlier and later, respectively, in the 

sewing order).

Another function of the sequence view is to show and hide the 

different color groups in the design. You can also lock one, or a 

number, of color groups so that they will not be editable. This 

allows you to make changes to an object in the design without 

affecting any of the other segments. 

See “Show/Hide and Lock Color Groups”, below.
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Changing Thread Colors in 
Sequence View
As well as changing the colors of a design in the main design 

window, you can also change them by selecting them in 

Sequence view. 

Sometimes it is easier to make thread color changes in 
Sequence View than in the design workspace, because you can 
always tell exactly which parts of the design you have selected. 
In the design workspace window, by contrast, color segments 
may overlap, making it difficult to choose only the one that you 
want to change.

To change thread colors:

1 Select a color group by clicking on the thread name in the 

Sequence View pane.

2 In the Color Palette area, do one of the following:

 Using the current list, click one of the color boxes with 
the thread color you want to use.

 From the drop-down list on the left side of the palette, 
select a Thread Chart and click one of the color boxes 
with the thread color you want to use.

The embroidery will change to the selected color.

Sequencing Color Groups
The sequence view shows the groups of your design in the 

order in which they will be sewn. Sequence is important, 

because you want color groups that are near to each other to 

sew out consecutively, if this is practical; this reduces jump 

stitches and the need to trim them later. There are two ways to 

change the sewing order in the sequence view: the “drag and 

drop” method and the “cut and paste” method.

You can also select multiple color groups at the same time using 
Sequence view. 

To select more than one color group, press Ctrl-click on each 
one. To select a series of consecutive color groups, click the first 
in the series you want to select, and then Shift-click the last. 
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To resequence color groups by dragging and dropping:

1 Select one or more color groups you want to resequence.

2 In the Sequence View area, drag the group(s) to the location 

in the sewing order that you want.

3 Release the mouse button.

The color group will be inserted in the new location.

To resequence color groups by cutting and pasting:

1 Select the group or groups.

2 With the group(s) selected, do one of the following:

 Right-click and choose Cut.

 Press Ctrl + X on the keyboard.

3 In the Sequence View area, click the color group where you 

want to insert the copied color group(s).

4 Do one of the following:

 Press Ctrl + I on the keyboard. 

 Right-click and choose Insert.

The cut color group will be inserted before the insertion point.

Show/Hide and Lock Color Groups
You can show or hide the color groupings in the design in 

Sequence View, and lock the color group to prevent it from 

being changed unintentionally.

To hide color groups:

• Click on the show groups icon  next to the group you 
wish to hide.
The icon is greyed out to indicate that the group is hidden. In 
the design workspace, you no longer see any of the 
unselected groups in the design.

To show a hidden color group:

• Click on the greyed-out show groups icon  next to the 

group or groups you wish to show.
In the design workspace, the hidden segments appear.
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To hide all other color groups:

1 Select a color group (or groups) in the sequence view.

2 Right-click, and select “Hide other” from the context menu.

All the color groups, except those selected, will be hidden.

To show all hidden color groups:

• In the sequence view area right-click and choose “Show all” 
from the context menu.
In the design workspace, all groups in the design appear.

To lock a color group:

• Click on the open lock  icon next to the color group you 

wish to lock.
The icon changes to the locked  icon; the attributes of the 
color group cannot be changed.

To unlock a color group:

• Click on the open lock icon next to the color group you 

wish to unlock.
The icon changes to the open lock  icon; the attributes of 
the color group can now be changed.

Using Color Sort
Color Sort  is a tool that helps you reduce the number of 

thread color changes in a design. Sometimes, your monogram 

design may end up having many more color changes than is 

necessary, for example, if you were to use the same multi-color 

decor several times. By applying Color Sort, you can potentially 

prevent many unnecessary thread changes.

The Color Sort tool intelligently “looks” at a design to see if any 

colors are repeated. It then looks to see if any of those repeated 

There are times that a color is used more than once in a design 
by necessity; for example, this may occur when colors overlap.
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colors can be combined into a single layer. If not, the color 

layers are left intact.

To use color sort:

1 Select the design, or part of the design, that you want to 

apply color sort to.

2 On the Home toolbar, click on the Color Sort  tool.

A notification box will open, showing how many colors the 
design has been reduced by.

Printing Designs

Changing a Design’s Print Settings
You can customize an embroidery design’s print settings. You 

can adjust the image size, and select the worksheet information 

that will be displayed in design printouts.

To change a design’s print settings:

1 From the Accelerator  menu, click the Print Preview  

tool.

You see the print preview window displaying your design.

2 Click Settings.

You see the Print Settings dialog.

Note: If you want to apply color sort only to some of the 
segments of the design, these segments must be selected first, 
and the sorting will only apply to those segments that are 
selected. 

On the other hand, if you wish to color sort the entire design, 
ensure that no segments are selected before performing the 
color sort. This will apply the color sort to all segments.
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3 Do any of the following:

 In the Margins area, enter the size of margins you want 
for your design worksheet.

 Select Print Actual Size to have your design print in its 
actual size.

 Select Print Company Name to have the name of your 
customer or project printed on your design worksheet. 
Enter the desired name in the box below.

 Select Remove Jump Stitches to prevent the jump 
stitches from being printed on the worksheet.

 Select Print Color Analysis to print a thread sequence 
view. 

4 Click OK.

5 Click Close.

Previewing a Design before Printing
You can preview a worksheet on the screen before sending it to 

the printer.

To preview a design:

1 From the Accelerator  menu, click the Print Preview  

tool.

You see the print preview window, displaying your design.
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2 To zoom in and out of the previewed worksheet, do the 

following:

 To zoom in on the worksheet, click Zoom In and scroll to 
view specific parts of the design.

 To zoom out on the worksheet, click Zoom Out and scroll 
to view specific parts of the design.

3 To change the settings for the design worksheet, click 

Settings.

4 Click OK.

5 To close print preview and return to the design window, click 

Close.
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Printing Design Worksheets
You can print worksheets for design files. When you print a 

worksheet for a design file, the worksheet information depends 

on the selected settings in the Print Settings.

To print a worksheet for your design:

1 From the Accelerator  menu, click the Print Preview  

tool.

You see the print preview window, displaying your design.

2 To change the settings for the design worksheet or check the 

information that will be printed on the worksheet, click 

Settings.

3 Click OK.

4 Click Print.

If you want to print a design worksheet with existing settings, 
choose the Print tool on the Accelerator menu. Then click OK 
from the Print dialog.
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Instruction Manual

I
Import Color dialog 37
Insert 9
Inset distance 65

K
Keystrokes 40

L
Locking a color group 72

M
Machine Formats 20
Magnifying views 21
Measuring designs 26
Merge Design tool 8
Merging designs 48
Metric units 19
Modify Tools 11
Monogram Designer 9, 33–48

Changing thread color 37
Fonts 39
Layout 34
New design 35

Monogram Frames 46
Monogram Template 47
Moving segments 58

N
New Design tool 8
New designs 17
New tool 8
Nudging segments 58

O
Open Design tool 8
Opening designs 16
Options 20

P
Pan tool 26
Panning 25
Percentage pull-compensation 
66
Previewing designs 74
Print Preview 8
Print Preview command 74
Print Setting 76
Print settings 73
Printing 76
Printing Designs 73
Printing Help topics 32
Pull-compensation 66
Pull-compensation, absolute 66
Pull-compensation, percentage 
66

R
Redo tool 9, 15
Reducing views 21
Reflecting segments 55
Removing hoops 27
Resize command 56
Resizing segments 56
Ruler tool 26

S
Save As command 18
Save as Template 47
Save command 19
Save tool 8
Saving a Monogram Template 
47
Saving Help Topics 31–32
Scrollbar slider 12, 13
Scrollbars 14
Select Hoop 10
Select tool 9, 11, 52
Selecting underlay types 63
Sequence View 53, 69
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Sequencing segments 70
Showing a color segment 71
Slant setting 60
Slow Draw Bar

Scrollbar slider 12, 13
Speed Control 13

Speed Control, drawing 13
Status Line 13

T
Thread Colors 68
Thread colors 14

changing 68, 70
Title Bar 6
Tools

Edit 8
Modify 11

Tools, Draw Bar 12, 13

U
Underlay stitch length 64
Underlay types 63
Undo tool 9, 15
Ungrouping objects 54
Unlocking a color segment 72

V
Vertical Center tool (Align) 11, 
56
Vertical Flip tool 55
Viewing designs 25, 58
Views tools 21

Zoom 21, 22

W
Width compensation 60
Worksheet Setting 76
Workspace 6
Workspace environment 19

Z
Zoom 10
Zoom tool 21


